Notice
The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in any way responsible for any loss or damage resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.
©February 2007

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.
Intel, Celeron, and Intel Core are trademarks/registered trademarks of Intel Corporation.
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit - Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz / DC Output 19V, 3.42A (65W).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   ![Diagram: Do not expose the computer to any shock or vibration.]
   Do not place it on an unstable surface.
   Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   ![Diagram: Do not expose it to excessive heat or direct sunlight.]
   Do not leave it in a place where foreign matter or moisture may affect the system.
   Don’t use or store the computer in a humid environment.
   Do not place the computer on any surface that will block the Vents/Fan Intakes.
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>

5. **Take care when using peripheral devices.**

<table>
<thead>
<tr>
<th>Use only approved brands of peripherals.</th>
<th>Unplug the power cord before attaching peripheral devices.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
</tbody>
</table>
Power Safety
The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

**Power Safety Warning**
Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

Do not plug in the power cord if you are wet.
Do not use the power cord if it is broken.
Do not place heavy objects on the power cord.
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not remove any batteries from the computer while it is powered on.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Preface

Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
Preface

On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.
## Preface

### Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notice</td>
<td>I</td>
</tr>
<tr>
<td>FCC Statement</td>
<td>II</td>
</tr>
<tr>
<td>Instructions for Care and Operation</td>
<td>IV</td>
</tr>
<tr>
<td>Power Safety</td>
<td>VI</td>
</tr>
<tr>
<td>Battery Precautions</td>
<td>VII</td>
</tr>
<tr>
<td>Cleaning</td>
<td>VIII</td>
</tr>
<tr>
<td>Servicing</td>
<td>VIII</td>
</tr>
<tr>
<td>Travel Considerations</td>
<td>IX</td>
</tr>
</tbody>
</table>

### Quick Start Guide

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>1-1</td>
</tr>
<tr>
<td>Model &amp; Design Differences</td>
<td>1-2</td>
</tr>
<tr>
<td>Advanced Users</td>
<td>1-3</td>
</tr>
<tr>
<td>Beginners and Not-So-Advanced Users</td>
<td>1-3</td>
</tr>
<tr>
<td>Warning Boxes</td>
<td>1-3</td>
</tr>
<tr>
<td>Not Included</td>
<td>1-4</td>
</tr>
<tr>
<td>System Software</td>
<td>1-5</td>
</tr>
<tr>
<td>System Startup</td>
<td>1-6</td>
</tr>
<tr>
<td>System Map: LCD Panel Open</td>
<td>1-7</td>
</tr>
<tr>
<td>LED Indicators</td>
<td>1-8</td>
</tr>
<tr>
<td>Hot Key Buttons</td>
<td>1-9</td>
</tr>
<tr>
<td>Keyboard</td>
<td>1-10</td>
</tr>
<tr>
<td>Function Keys</td>
<td>1-11</td>
</tr>
</tbody>
</table>

### Features & Components

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>2-1</td>
</tr>
<tr>
<td>Hard Disk Drive</td>
<td>2-2</td>
</tr>
<tr>
<td>Optical (CD/DVD) Device</td>
<td>2-3</td>
</tr>
<tr>
<td>Loading Discs</td>
<td>2-3</td>
</tr>
<tr>
<td>Handling CDs or DVDs</td>
<td>2-4</td>
</tr>
<tr>
<td>DVD Regional Codes</td>
<td>2-5</td>
</tr>
<tr>
<td>7-in-1 Card Reader</td>
<td>2-6</td>
</tr>
<tr>
<td>ExpressCard Slot</td>
<td>2-7</td>
</tr>
<tr>
<td>Inserting and Removing ExpressCards</td>
<td>2-7</td>
</tr>
<tr>
<td>TouchPad and Buttons/Mouse</td>
<td>2-8</td>
</tr>
<tr>
<td>Function Keys/Hot Keys</td>
<td>2-9</td>
</tr>
<tr>
<td>Application Quick Buttons</td>
<td>2-11</td>
</tr>
<tr>
<td>Recording Audio</td>
<td>2-12</td>
</tr>
</tbody>
</table>
## Preface

- Audio Features .............................................................2-14
- S/PDIF-Out Support .................................................2-15
- Adding a Printer ...........................................................2-16
- USB Printer ..............................................................2-16
- Parallel Printer ..........................................................2-16

## Power Management

- Overview .................................................................3-1
- The Power Sources ...................................................3-2
- AC/DC Adapter .......................................................3-2
- Battery .................................................................3-2
- Turning on the Computer ..........................................3-3
- Power Plans .............................................................3-4
- System Power Options .............................................3-6
- Hibernate vs. Shut Down ...........................................3-6
- Sleep vs. Hibernate ..................................................3-6
- Sleep .................................................................3-7
- Hibernate .............................................................3-7
- Configuring the Power Buttons .................................3-8
- Battery Information ..................................................3-9
- Battery Power ..........................................................3-9
- Conserving Battery Power .......................................3-10
- Battery Life ............................................................3-11
- New Battery ............................................................3-11
- Recharging the Battery with the AC/DC Adapter .......3-11

## Drivers & Utilities

- What to Install ..........................................................4-1
- Module Driver Installation .........................................4-1
- Driver Installation ....................................................4-2
- Updating/Reinstalling Individual Drivers ..................4-3
- Manual Driver Installation ..........................................4-4
- User Account Control (Win Vista) .........................4-5
- Windows Security Message ......................................4-5
- New Hardware Found ................................................4-5
- Driver Installation Procedure .................................4-5
- Video .................................................................4-5
- Audio .................................................................4-5
- Modem .................................................................4-6
- TouchPad ...............................................................4-6
- CardReader .............................................................4-6
- Hot-Key Buttons ......................................................4-6
- Application Quick Button ........................................4-7
- Wireless LAN ..........................................................4-8
- Bluetooth ...............................................................4-8
- PC Camera .............................................................4-8

- Proper handling of the Battery Pack .........................3-12
- Battery FAQ ............................................................3-13
**BIOS Utilities**

Overview ................................................................. 5-1  
The Power-On Self Test (POST) .............................. 5-2  
The Setup Program ...................................................... 5-3  
   Entering Setup .......................................................... 5-3  
   Setup Screens .......................................................... 5-4  
Main Menu ................................................................. 5-5  
System Time & Date (Main Menu) ............................... 5-5  
IDE Channel 0 Master/IDE Channel 1 Master (Main Menu) ......................................................... 5-6  
System/Extended Memory (Main Menu) ....................... 5-6  
Advanced Menu ......................................................... 5-7  
   Chipset Information Menu: (Advanced Menu) ........ 5-7  
   Reset Configuration Data: (Advanced Menu) ........... 5-8  
   Legacy USB Support: (Advanced Menu) ................. 5-8  
   Boot-time Diagnostic Screen: (Advanced Menu) ... 5-8  
   Power on Boot Beep: (Advanced Menu) ................. 5-8  
   Battery Low Alarm Beep: (Advanced Menu) .......... 5-8  
   Total Graphics Memory: (Advanced Menu) ............ 5-8  
Security Menu ............................................................ 5-9  
   Set Supervisor Password (Security Menu) .............. 5-9  
   Password on boot: (Security Menu) ......................... 5-10  
   Boot Menu ............................................................... 5-11  
Exit Menu .................................................................... 5-12  

**Upgrading The Computer**

Overview ................................................................. 6-1  
   When Not to Upgrade .............................................. 6-2  
   Removing the Battery .............................................. 6-3  
   Upgrading the Hard Disk Drive ............................... 6-4  
   Upgrading the Optical (CD/DVD) Device ................. 6-6  
   Upgrading the System Memory (RAM) .................... 6-7  
   Upgrading the Processor ......................................... 6-10  

**Modules & Options**

Overview ................................................................. 7-1  
   Wireless LAN Module ............................................. 7-2  
      Intel WLAN Driver Installation .......................... 7-2  
      802.11 b/g WLAN Driver Installation .................. 7-2  
   Connecting to a Wireless Network .......................... 7-3  
      Windows Mobility Center .................................... 7-6  
   Bluetooth Module .................................................... 7-7  
      Bluetooth Driver Installation ............................ 7-7  
   PC Camera Module ..................................................... 7-9  
      PC Camera Driver Installation ............................ 7-10  
      PC Camera Audio Setup ..................................... 7-11  
      BisonCap ............................................................ 7-13  
      Eliminating Screen Flicker ................................. 7-14  
      PC Camera Hot Key Buttons ............................... 7-15  

Preface

Troubleshooting
Overview ................................................................. 8-1
Basic Hints and Tips .................................................. 8-2
Backup and General Maintenance ............................... 8-3
Viruses ...................................................................... 8-4
Upgrading and Adding New Hardware/Software ........... 8-5
Problems and Possible Solutions ................................. 8-7

Interface (Ports & Jacks)
Overview .................................................................. A-1
Notebook Ports and Jacks ........................................... A-2
Card Reader Port ........................................................ A-2
DC-In Jack ................................................................ A-2
External Monitor (VGA) Port ........................................ A-2
Headphone-Out Jack ................................................... A-2
Line-In Jack ............................................................... A-2
Microphone-In Jack .................................................... A-2
Mini-IEEE 1394 Port .................................................. A-3
RJ-11 Modem Jack ..................................................... A-3
RJ-45 LAN Jack ........................................................ A-3
Security Lock Slot ..................................................... A-3
Serial Port ................................................................. A-3
S/PDIF-Out Jack ........................................................ A-4
7-Pin S-Video-Out Jack .............................................. A-4
USB 2.0/1.1 Ports ...................................................... A-4

Intel Video Driver Controls
Intel Video Driver Installation ...................................... B-1
Video (VGA) ............................................................. B-1
Dynamic Video Memory Technology .......................... B-1
Intel Graphics Properties ............................................ B-2
Scheme Options ....................................................... B-4
Display Devices ........................................................ B-5
Attaching Other Displays ........................................... B-6
Display Modes ......................................................... B-8
TV Settings ............................................................. B-13

Specifications
Processor .................................................................... C-1
Core Logic .................................................................. C-1
Memory ...................................................................... C-2
Video Adapter ........................................................... C-2
Security ..................................................................... C-2
BIOS ......................................................................... C-2
LCD ........................................................................... C-2
Storage ...................................................................... C-2
Audio ......................................................................... C-3
Keyboard & Pointing Device ....................................... C-3
Interface ................................................................. C-3
Card Reader ............................................................. C-3
Preface

ExpressCard Slot .......................................................... C-3
Communication ............................................................. C-4
Power Management ...................................................... C-4
Power ............................................................................ C-4
Battery ........................................................................... C-4
Environmental Spec ...................................................... C-4
Dimensions ................................................................... C-4
& Weight ...................................................................... C-4
Optional ........................................................................ C-5

Windows XP Information

DVD Regional Codes ................................................... D-2
Windows XP Start Menu & Control Panel ................... D-3
Function Keys/Hot Keys ............................................... D-4
Recording Audio........................................................... D-6
Application Quick Buttons ........................................... D-8
Audio Features .............................................................. D-9
TouchPad and Buttons/Mouse .................................... D-11
  Configuring the TouchPad and Buttons .................. D-11
Video Features ............................................................. D-12
Display Devices & Options ......................................... D-15
Attaching Other Displays ........................................... D-16
TV Settings ................................................................. D-20
Power Settings ............................................................. D-21
Power Management Features ..................................... D-22
System Power Options................................................. D-23
Stand by Mode vs. Hibernate Mode ............................ D-23
Configuring the Power Button .................................... D-25
Battery Information ..................................................... D-26
Recharging the Battery with the AC/DC Adapter ...... D-27
Battery FAQ................................................................. D-29
Driver Installation ....................................................... D-30
Drivers Installer Application ....................................... D-31
Updating/Reinstalling Individual Drivers .................. D-32
Bluetooth Module ....................................................... D-35
PC Camera ................................................................. D-37
BisonCap ..................................................................... D-41
PC Camera Hot Key Buttons ....................................... D-43
Wireless LAN Module ................................................ D-44
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

- **Chapter 2** A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, 7-in-1 card reader, ExpressCard/34/54), Function/Hot Keys, TouchPad & Mouse, Audio & Printer.
- **Chapter 3** The computer’s power saving options.
- **Chapter 4** The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
- **Chapter 5** An outline of the computer’s built-in software or BIOS (Basic Input Output System).
- **Chapter 6** Instructions for upgrading your computer.
- **Chapter 7** A quick guide to the computer’s Wireless LAN, Bluetooth, and PC Camera modules (some of which may be optional depending on your purchase configuration).
- **Chapter 8** A troubleshooting guide.
- **Appendix A** Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
- **Appendix B** Information on the Intel video driver controls.
- **Appendix C** The computer’s specification.
- **Appendix D** Information on the Windows XP OS.
Quick Start Guide

Model & Design Differences

This notebook series includes two different model types (Model A or Model B) based upon the battery type supported (see Table 1 - 1 below). The series also includes three different designs which vary slightly in color and appearance. However the designs incorporate the same features, ports and jacks etc.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Model A</th>
<th>Model B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery Types</td>
<td>6 Cell Smart Lithium-Ion Battery Pack, 4400mAH (48.8W)</td>
<td>6 Cell Smart Lithium-Ion Battery Pack, 4000mAH (44.4W)</td>
</tr>
</tbody>
</table>

*Table 1 - 1 - Model Differences*

See “Battery” on page C - 4 for full details.
Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.
Quick Start Guide

Not Included
Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4 - 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you); refer to Chapter 4 for installation instructions.

Ports and Jacks
See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the following operating systems are supported.

<table>
<thead>
<tr>
<th>Operating System &amp; Version</th>
<th>Supported</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Windows XP (Home or Professional)</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Windows Vista Home Basic</td>
<td>32-bit Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>64-bit No</td>
<td></td>
</tr>
<tr>
<td>Windows Vista Home Premium</td>
<td>32-bit Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>64-bit No</td>
<td></td>
</tr>
<tr>
<td>Windows Vista Business/Enterprise/Ultimate</td>
<td>32-bit Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>64-bit No</td>
<td></td>
</tr>
</tbody>
</table>

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Windows XP Information” on page D - 1.
System Startup

1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
5. Raise the lid/LCD to a comfortable viewing angle, and press the power button to turn the computer “on”.
6. Adjust the LCD panel to a comfortable viewing angle.
7. The LED indicators show the power and battery status of the computer.

*Figure 1 - 1 - AC/DC Adapter In*

Note that you should always shut your computer down by choosing the **Shut Down** command from the **Lock Button Menu** in *Windows Vista*. This will help prevent hard disk or system problems.
System Map: LCD Panel Open

1. Optional Built-In PC Camera
2. LCD
3. Speakers
4. Power Button
5. Hot Key Buttons
6. Keyboard
7. TouchPad and Buttons
8. Built-In Microphone
9. LED Indicators

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the key combinations to toggle power to the WLAN/Bluetooth modules, and check the LED indicator icon to see if the modules are powered on or not (see Table 1 - 3, on page 1 - 8, Table 1 - 5, on page 1 - 11).

Figure 1 - 2 - LCD Panel Open
**LED Indicators**

The LED indicators display helpful information about the current status of the computer.

*Table 1 - 3 - LED Indicators*

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>Green</td>
<td>Number Lock Activated</td>
</tr>
<tr>
<td>☐</td>
<td>Green</td>
<td>Caps Lock Activated</td>
</tr>
<tr>
<td>☐</td>
<td>Green</td>
<td>Scroll Lock Activated</td>
</tr>
<tr>
<td>☐</td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td>☐</td>
<td>Blinking Green</td>
<td>The Computer is in Stand by Mode</td>
</tr>
<tr>
<td>☐</td>
<td>Orange</td>
<td>The AC/DC Adapter is Plugged In &amp; the Computer is Powered Off</td>
</tr>
<tr>
<td>☐</td>
<td>Orange</td>
<td>The AC/DC Adapter is Plugged In &amp; the Battery is Charging</td>
</tr>
<tr>
<td>☐</td>
<td>Blinking Orange</td>
<td>The Battery has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>☐</td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td>☐</td>
<td>Green</td>
<td>Hard Disk Activity</td>
</tr>
<tr>
<td>☐</td>
<td>Green</td>
<td>The WLAN/Bluetooth Module(s) is/are Powered On</td>
</tr>
</tbody>
</table>
Hot Key Buttons

These buttons give instant access to the functions indicated in the table below. The Application and zoom hot key functions depend on whether or not a PC Camera module installed.

Table 1 - 4 - Hot Key Buttons

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Function</th>
</tr>
</thead>
</table>
| 📹      | PC Camera Installed
|         | Activate the BisonCap program/Take Still Picture (See Page 7 - 15)       |
|         | PC Camera Not Installed
|         | Activate Application Quick Button 1 (See Page 2 - 11)                    |
| 🌐      | PC Camera Installed
|         | Activate the Default Internet Program                                     |
|         | PC Camera Not Installed
|         | Activate the Default E-Mail Browser                                      |
| 🎧      | PC Camera Installed
|         | Audio Record Start/Stop (See Page 2 - 12)                                |
|         | PC Camera Not Installed
|         | Activate Application Quick Button 2 (See Page 2 - 11)                    |
| 🕵️‍♂️    | PC Camera Installed
|         | Camera Zoom-In (See Page 7 - 15)                                          |
|         | PC Camera Not Installed
|         | Activate Application Quick Button 3 (See Page 2 - 11)                    |
| 💼      | PC Camera Installed
|         | Camera Zoom-Out (See Page 7 - 15)                                         |
|         | PC Camera Not Installed
|         | Activate Application Quick Button 3 (See Page 2 - 11)                    |
Keyboard

The keyboard has a numerical keypad for easy numeric data input, and features function keys to allow you to change operational features instantly (see Figure 1 - 3).

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may not work.
Function Keys

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the **Fn** key is held down.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F8</td>
<td>Decrease LCD Brightness</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>TouchPad Toggle</td>
<td>Fn + F9</td>
<td>Increase LCD Brightness</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off (Press a key to or use TouchPad to turn on)</td>
<td>Fn + F10</td>
<td>PC Camera Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F11</td>
<td>Wireless LAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F5</td>
<td>Decrease Audio Volume</td>
<td>Fn + NumLk</td>
<td>Number Lock Toggle</td>
</tr>
<tr>
<td>Fn + F6</td>
<td>Increase Audio Volume</td>
<td>Fn + ScrLk</td>
<td>Scroll Lock Toggle</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Table 1 - 5 - Function Keys*

**Special Characters**

Some software applications allow the number-keys to be used with **Alt** to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that **NumLk** is on.
Quick Start Guide

System Map: Front & Rear Views

Figure 1 - 4 - Front & Rear Views

1. LED Indicators
2. Serial Port
3. Mini-IEEE 1394 Port
4. 1 * USB Port
5. DC-In Jack
6. Battery

Mini-IEEE 1394

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.
System Map: Left View

Figure 1 - 5 - Left View

1. Security Lock Slot
2. Optical Device Drive Bay
   (see page 2 - 3)
3. RJ-11 Modem Jack
4. S/PDIF-Out Jack
5. Microphone-In Jack
6. Headphone-Out Jack
7. Line-In Jack

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or similar object that may break and become lodged in the hole.

Media Warning

Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to "crash".

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (Hardware and Sound), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
Quick Start Guide

System Map: Right View

ExpressCard Slot
The ExpressCard Slot accepts either ExpressCard/34 or ExpressCard/54 formats.

7-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:
- MMC (MultiMedia Card) / SD (Secure Digital) /
- MS (Memory Stick) / MS Pro (Memory Stick Pro)
- MS Duo (requires PC adapter) / Mini SD (requires PC adapter) /
- RS MMC (requires PC adapter)
System Map: Bottom View

*Figure 1 - 7 - Bottom View*

1. Vent/Fan Intake
2. Battery
3. Hard Disk Bay Cover
4. CPU/RAM Bay Cover

---

**CPU**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

**Overheating**

To prevent your computer from overheating make sure nothing blocks any Vent/Fan Intake while the computer is in use.

---

**Battery Information**

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 9 for full instructions.
Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within *Windows Vista* (and most other *Windows* versions) are accessed from the **Start** menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the **Start** menu and/or the desktop. Right-click the **Start menu** icon and then select **Properties** if you want to customize the appearance of the **Start** menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in *Windows* (e.g. power, video, network, audio etc.). *Windows Vista* provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers listed in *Table 4 - 1, on page 4 - 3*. To see all controls it may be necessary to toggle to Classic View on.
Video Features

Your computer has built-in Intel (Intel 945GM) video. You can switch display devices, and configure display options, from the Display Settings control panel (in Personalization) in Windows Vista as long as the appropriate Intel video driver is installed.

To access Display Properties in Windows Vista:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution: 1(Figure 1 - 9 on page 1 - 18).
4. Click the arrow, and scroll to the preferred setting in Colors: 2(Figure 1 - 9 on page 1 - 18).
5. Click Advanced Settings (button) 3(Figure 1 - 9 on page 1 - 18) and click Intel(R) GMA Driver for mobile (tab).
6. Click Graphics Properties (button) 4(Figure 1 - 9 on page 1 - 18) to access the Intel GMA control panel (this control panel can also be accessed by double-clicking Intel(R) GMA Driver for mobile in Classic View).
7. The Intel GMA control panel can also be accessed by clicking the icon in the taskbar and selecting Graphics Properties from the menu.

Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display connected to the external monitor port as your display device.
Quick Start Guide

Figure 1 - 9 - Display Properties Desktop

<table>
<thead>
<tr>
<th>Intel Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Mode</td>
<td>One of the connected displays is used as the display device</td>
</tr>
<tr>
<td>Intel(R) Dual Display Clone Mode</td>
<td>Both connected displays output the same view and may be configured independently</td>
</tr>
<tr>
<td>Extended Desktop Mode</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

Table 1 - 6 - Display Options

1 - 18 Video Features
Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 16) allows you to configure power management features for your computer. You can conserve power by means of power plans and configure the options for the power button, sleep button, computer lid (when closed), display and sleep mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create a new plan. Click Change Plan Settings and click Change advanced power settings to access further configuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 9.

Note: Sleep is the default power saving state in Windows Vista

Figure 1 - 10 - Power Options
Chapter 2: Features & Components

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical (CD/DVD) Device
- 7-in-1 Card Reader
- ExpressCard Slot
- TouchPad and Buttons/Mouse
- Function Keys/Hot Keys
- Application Quick Buttons
- Recording Audio
- Audio Features
- Adding a Printer
Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5” serial (SATA) hard disk drives (see “Storage” on page C - 2) with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For further details see “Upgrading the Hard Disk Drive” on page 6 - 4.
Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the module you purchased (see “Storage” on page C - 2). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 11).

Loading Discs

To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator  will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole  to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting (see “Function Keys/Hot Keys” on page 2 - 9).
2 - 4 Optical (CD/DVD) Device

Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not attach paper or other materials to the surface of the disc.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.

CD Emergency Eject
If you need to manually eject a CD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. However please do NOT use a sharpened pencil or similar object that may break and become lodged in the hole.

Disk Eject Warning
Don't try to remove a CD/DVD while the system is accessing it. This may cause the system to “crash”.

**DVD Regional Codes**

To change the DVD regional codes see "Changing DVD Regional Codes" on page 1 - 13.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

Table 2 - 1

DVD Regional Coding

Figure 2 - 3

DVD Regions
Features & Components

2 - 6 7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the ExpressCard/Card Reader driver (see “CardReader” on page 4 - 6).

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS Pro (Memory Stick Pro)
- MS Duo (requires PC adapter*)
- Mini SD (requires PC adapter*)
- RS MMC (requires PC adapter*)

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover
Make sure you keep the rubber cover provided in the card reader when not in use. This will help prevent foreign objects and/or dust getting in to the card reader.

Figure 2 - 4
Right View

1. Card Reader
ExpressCard Slot

The computer is equipped with an **ExpressCard/34/54** slot that reads Express Card/34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g. CompactFlash card reader. The number denotes the card width; 54mm for the Express Card/54 and 34mm for the ExpressCard/34. Make sure you install the ExpressCard/Card Reader driver (see “CardReader” on page 4 - 6).

Inserting and Removing ExpressCards

- Align the ExpressCard with the slot and push it in until it locks into place.
- To remove an ExpressCard, simply press the card to eject it.

ExpressCard Slot

Make sure you keep the rubber cover provided in the ExpressCard slot when not in use. This will help prevent foreign objects and/or dust getting in to the ExpressCard Slot.
TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse.

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you can configure the functions by double-clicking the TouchPad driver icon on the taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences.

Mouse Driver

If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device’s user documentation for details.

Figure 2 - 6
Mouse Properties
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the basic function key combinations; visual indicators are available when the hot key driver is installed (see “Hot-Key Buttons” on page 4 - 6). After installing the driver an icon will appear in the taskbar.

Double-click the icon to bring up the configuration menu to set the time for the visual indicators to be displayed on screen. Click OK to minimize the program (if you click the close icon see the sidebar).

The hot key buttons on the left side of the computer give quick access to the default internet browser and e-mail program. The PC Camera hot key buttons can be used to run the BisonCap application, to take still pictures and to zoom the camera in/out (see “PC Camera Hot Key Buttons” on page 7 - 15) if a PC Camera module is installed. If you do not have a PC Camera module installed see “Application Quick Buttons” on page 2 - 11 for details.
### Features & Components

#### 2 - 10 Function Keys/Hot Keys

<table>
<thead>
<tr>
<th>Fn/Hot Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + F1</td>
<td>TouchPad Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
</tr>
<tr>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td></td>
<td>Activate BisonCap Program/Take Still Picture</td>
</tr>
<tr>
<td></td>
<td>Audio Record Start/Stop (see over)</td>
</tr>
</tbody>
</table>

*Table 2 - 2: Hot Key & Function Key Combo Indicators*
Application Quick Buttons

Note that the application quick button utility is designed to allow use of the hot key buttons in absence of the optional PC Camera (only install the application quick button utility if the PC Camera is not installed). You will need to install the Quick Button Utility (see “Application Quick Button” on page 4 - 7) to enable the functions.

The quick buttons give instant access to user-defined applications, with one quick button press. To configure a program to open when the buttons (see Table 1 - 4, on page 1 - 9) are pressed, follow the instructions below. The quick buttons will function as long as the program is running (the icon will appear in the taskbar). If the program is not running you will need to restart the computer.

1. **Press a button** or right-click the icon in the taskbar.
2. Select **Setup** from the menu, scroll to AP1/2/3 and select **Custom**.
3. An **Open** dialog box will appear on the screen.
4. **Browse** to the directory where the desired application.exe (see sidebar) program exists.
5. **Double-Click** on the program file or choose *Open*.

![Figure 2 - 8 Quick Button Configuration Screens](application.exe)
Recording Audio

The audio record hot key button allows you to record audio (the hot key program must be running - see sidebar) from either the built-in microphone, or from a microphone connected to the microphone-in jack. To record on the computer, setup the audio recording options in Windows as follows (see Figure 2 - 9 on page 2 - 13).

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Line-In/Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Line-In/Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Line-In/Microphone slider to the level required.
7. Click OK and close the control panels.
8. Press the audio record button to begin the recording process (the record icon will flash in the top left of the screen).
9. Press the audio record button again to stop the recording process (the record icon will disappear from the top left of the screen).
10. The recorded audio file (in .wav format) will appear in the wav folder in the Users folder (C:|Users|wav).
11. Double-click the file to playback the recorded audio.
Features & Components

Audio Setup for Recording (Windows Vista)

Figure 2 - 9

Recording Audio 2 - 13
Audio Features

You can configure the audio options on your computer from the **Sound** control panel in **Windows**, or from the **Realtek HD Audio Manager** icon in the taskbar/control panel (right-click the taskbar icon to bring up an audio menu). The volume may also be adjusted by means of the `Fn + F5/F6` key combination.

![Image of Realtek Audio Manager](image-url)

Figure 2-10
Realtek Audio Manager

Right-click the icon to access the menu above.
S/PDIF-Out Support

If you wish to configure your system for S/PDIF-Out sound support, then follow the instructions below:

1. Double-click the icon in the taskbar to access the Realtek HD Audio Manager menu.
2. Right-click the Analog Back Panel icon, and click to select Connector Retasking.
3. Click to put a tick in the S/PDIF-Out box, and click OK.
4. Click OK to close the Realtek HD Audio Manager menu.

Figure 2 - 11
S/PDIF-Out Setup
(Windows Vista)
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer; however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar, however you will need to purchase a parallel to USB converter.
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• System Power Options
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user’s manual of your operating system.

(Note: All pictures used on the following pages are from the Windows Vista OS.)
The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 13).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 9.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options (Hardware and Sound menu) control panel in Windows Vista to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds. You may configure the options for the power button from the Power Options (Hardware and Sound menu) control panel in Windows Vista (see your OS’s documentation, or “Configuring the Power Buttons” on page 3 - 8 for details).

Shut Down

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu in Windows Vista. This will help prevent hard disk or system problems.
Power Management

Power Plans

The computer can be configured to conserve power by means of power plans. You can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.

Figure 3-1
Power Plan Advanced Settings

Resuming Operation

If the display is off the system can resume by pressing any key on the keyboard.

The system can resume from Sleep mode by pressing the Sleep Button key combination (Fn + F4), or power button.

Password

It is recommended that you enable a password on system resume in order to protect your data.
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.

![Figure 3 - 2 Power Plans](image-url)
Power Management

System Power Options

You can use the system power options to stop the computer’s operation and restart where you left off. The system features **Sleep** and **Hibernate** power saving states (**Hibernate** will need to be enabled from power plan **Advanced Settings** see **Figure 3 - 1 on page 3 - 4**).

**Hibernate vs. Shut Down**

Hibernate and Shut Down are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

**Sleep vs. Hibernate**

If you want to stay away from your work for just a while, you can put the system into **Sleep** instead of in hibernation. It takes a longer time to wake up the system from **Hibernate** mode than from **Sleep** mode. **Sleep** will effectively act as **Hibernate** if the computer battery becomes depleted (see “**Sleep Mode & Mobile PC Battery**” on page 3 - 7).
Sleep

Sleep uses very little system power, and takes a short time to return to full operation. After an extended period of time in Sleep the computer will save the contents of system memory (e.g. any open documents and applications) to the hard disk and shut the system down. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Sleep mode to save power.

Hibernate

Hibernate uses no power and saves all of your information on a part of the hard disk before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate when the battery power is almost depleted. You will need to enable Hibernate mode from the Advanced Settings in power plans, or you put the system directly into Hibernate mode from the Lock Button Menu. The system will resume from Hibernate mode by pressing the power button.

Figure 3 - 3

Lock Button Menu
Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to either Sleep or Hibernate. In Sleep mode the LED will blink green. In Hibernate mode the LED will be off. If only the display is turned off, the LED will remain green.

Password Protection

It is recommended that you enable a password on wake up in order to protect your data. However you can disable this setting from the Power Options menu by clicking Require a password on wakeup in the left menu, and selecting the options (click Change settings that are currently unavailable).

Figure 3 - 4
Power Options Define Power Buttons
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon in the taskbar to see the current battery level and charge status.

Low Battery Warning

When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.

Figure 3 - 5
Battery Icon (Taskbar) & Battery Advanced Settings
Power Management

Conserving Battery Power

- Use a power plan that conserves power (e.g. Power saver), however note that this may have an affect on computer performance.
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Reduce the amount of time before the display is turned off.
- Close wireless, Bluetooth, modem or communication applications when they are not being used.
- Disconnect/remove any unnecessary external devices e.g. USB devices, Express-Cards etc.

Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

Figure 3-6
Windows Mobility Center
Battery Life

Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 13 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 8 for information on the battery charge status, and to “Battery Information” on page 3 - 9 for more information on how to maintain and properly recharge the battery pack.)
Power Management

Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Caution
Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.

Damaged Battery Warning
Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power settings.

Figure 3 - 7
Power Plan Create
Power Management

4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 0%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing

*Figure 3 - 8*
Power Options
Advanced Settings - Battery

3 - 14 Battery Life
How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Power Management
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

What to Install

The Device Drivers & Utilities + User’s Manual CD-ROM (Win Vista OR WinXP) contains the drivers and utilities necessary for the proper operation of the computer. There will be two CDs provided; one will contain drivers for Windows Vista, the other will contain drivers for Windows XP (make sure you install the appropriate drivers for your system).

Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that the drivers are installed in the order indicated (see “Driver Installation” on page D - 30 for Windows XP information).

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, Bluetooth, and PC Camera modules are provided in “Modules & Options” on page 7 - 1.
Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities + User’s Manual CD-ROM and click Install Vista Drivers (button), or Install Option Drivers (button) to access the Optional driver menu.

If you wish to install the drivers manually see page 4 - 4.

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out (if you need to reinstall any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Note that the Quick Button Driver only appears if you DO NOT have a PC Camera Module installed.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2
Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the driver (if it is not listed see below) and click Uninstall, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the Programs and Features menu:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Device Manager (Hardware and Sound > Device Manager).
3. Double-click the device you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click Driver (tab) and click the Update Driver or Uninstall button and follow the on screen prompts.

**Table 4 - 1 - Driver Installation**

<table>
<thead>
<tr>
<th>Driver</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Modem</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>CardReader</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Hot-Key Buttons</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Application Quick Button (Only appears if no PC Camera module is installed)</td>
<td>Page 4 - 7</td>
</tr>
<tr>
<td>Wireless LAN Module</td>
<td>Page 7 - 2</td>
</tr>
<tr>
<td>Bluetooth Module</td>
<td>Page 7 - 7</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Page 7 - 9</td>
</tr>
</tbody>
</table>
**Drivers & Utilities**

**Manual Driver Installation**

If you wish to install the drivers manually, click the Exit button to quit the *Drivers Installer* application, and then browse to the executable file in the location listed in the table below and follow the installation procedure for each driver. **Note that X is the drive letter assigned to the CD/DVD-ROM drive.**

<table>
<thead>
<tr>
<th>Driver</th>
<th>Driver Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>Vista 32bit: X:\Drivers\32bit\01_Video\Setup.exe</td>
</tr>
<tr>
<td>Audio</td>
<td>Vista 32bit: X:\Drivers\32bit\02_Audio\Setup.exe</td>
</tr>
<tr>
<td>Modem</td>
<td>Vista 32bit: X:\Drivers\32bit\03_Modem\setup.exe</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Vista 32bit: X:\Drivers\32bit\04_Touchpad\setup.exe</td>
</tr>
<tr>
<td>CardReader</td>
<td>Vista 32bit: X:\Drivers\32bit\05_CardReader\setup.exe</td>
</tr>
<tr>
<td>Hot-Key Buttons</td>
<td>Vista 32bit: X:\Drivers\32bit\06_Hotkey\Setup.exe</td>
</tr>
<tr>
<td>Application Quick Button</td>
<td>Vista 32bit: X:\Drivers\32bit\06_Hotkey\Quickbutton\3AP.exe</td>
</tr>
<tr>
<td>Wireless LAN Module</td>
<td>Vista 32bit: X:\Drivers\32bit\Option\07_WLAN\Intel\iProDifX.exe (For Intel PRO/Wireless 3945ABG) OR Vista 32bit: X:\Drivers\32bit\Option\07_WLAN\GUI\Setup.exe (For 802.11b/g USB WLAN)</td>
</tr>
<tr>
<td>Bluetooth Module</td>
<td>Vista 32bit: X:\Drivers\32bit\Option\08_Bluetooth\setup.exe</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Vista 32bit: X:\Drivers\32bit\Option\09_Camera\setup.exe</td>
</tr>
</tbody>
</table>

*Table 4 - 2 - Driver Location*
User Account Control (Win Vista)
If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or Install to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” (Found New Hardware Wizard) during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure as directed.

Driver Installation Procedure

Video
1. Click 1.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 2.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.
Drivers & Utilities

Modem
1. Click 3. Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

CardReader
1. Click 5. Install CardReader Driver > Yes.
2. Click Next.
3. Click the button to accept the license and click Next.
4. Click Finish.

Hot-Key Buttons
1. Click 6. Install Hotkey Driver > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

TouchPad
1. Click 4. Install Touchpad Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.
4. You may then configure your TouchPad as outlined in “TouchPad and Buttons/Mouse” on page 2 - 8.
Application Quick Button

If you **do not have a PC Camera** module installed, then the Quick Button Utility will appear in the Drivers Installer menu (**only install the quick button driver if the PC Camera is not installed**). See *Table 1 - 4, on page 1 - 9* and “Application Quick Buttons” on page 2 - 11 for details.

1. Click **7.Install Quickbutton Driver > Yes.**
2. Click **Next.**
3. Click **Finish** to restart your computer.

---

**Adding/Removing a PC Camera**

Note that the Quick Button and PC Camera drivers cannot co-exist.

If you wish to **add** a PC Camera module to your computer at a later date, then uninstall the Quick Button Driver (entitled **Multimedia Keyboard Driver**) before installing the PC Camera and driver. Drivers can be uninstalled from the **Programs and Features** (Programs > Uninstall a program) control panel in **Windows**.

If you wish to **remove** a PC Camera module from your computer at a later date, then uninstall the PC Camera Driver after removing the camera module. You can then insert the **Device Drivers & Utilities + User’s Manual CD-ROM** and install the **Quick Button** driver from the Driver Installation menu.
Drivers & Utilities

Wireless LAN
See the introduction in "Wireless LAN Module" on page 7 - 2, and check the installation procedure.

Bluetooth
See the introduction in "Bluetooth Module" on page 7 - 7, and check the installation procedure.

PC Camera
See the introduction in "PC Camera Module" on page 7 - 9, and check the installation procedure.
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

**Diagnostics:** The POST (Power-On Self Test)

**Configuration:** The *Setup* utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in *Setup*. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing*. Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

**Warning**
Incorrect settings can cause your system to malfunction. To correct mistakes, return to Setup and restore the *Setup Defaults* with <F9>.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.

Figure 5 - 1
POST Screen

POST Screen
1. BIOS information
2. CPU type
3. Memory status
4. Enter Setup prompt appears only during POST

Note: The POST screen as pictured right is for guideline purposes only. The POST screen on your computer may appear slightly different. If you disable the Boot-time Diagnostic Screen, the POST screen will not appear.

Phoenix TrustedCore(tm) NB
Copyright 1985-2005 Phoenix Technologies Ltd.
All Rights Reserved
Bios Revision: ******
KBC/EC Var: ******

CPU = 1 Processors Detected, Cores per Processor - 2
Intel(R) Core(TM)2 CPU T2700 @ 2.00GHz
1015M System RAM Passed
4096 KB L2 Cache
System BIOS shadowed
Video BIOS shadowed
Fixed Disk 0: TOSHIBA MK6034GSX
ATAPI CD-ROM: TSSTcorpCD/DVDW TS-L632D
Mouse initialized

Press <F2> to enter SETUP
The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt (Press F2 to Enter Setup) seen on page 5 - 3 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.
Setup Screens

The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ► next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
**Main Menu**

<table>
<thead>
<tr>
<th>PhoenixBIOS Setup Utility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main</td>
</tr>
</tbody>
</table>

- **System Time:** 22:12:05
- **System Date:** 01/15/2007
- **IDE Channel 0 Master:** 60012MB SATA1
- **IDE Channel 1 Master:** CD-ROM
- **System Memory:** 640 KB
- **Extended Memory:** 1014 MB

**System Time & Date (Main Menu)**
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
BIOS Utilities

**IDE Channel 0 Master/IDE Channel 1 Master (Main Menu)**
Pressing **Enter** opens the sub-menu to show the configuration of either a CD Device or HDD on the computer’s IDE Channel 0/SATA port 1. Use the **Auto** (Type:) setting to have the items configured automatically for you.

**System/Extended Memory (Main Menu)**
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.
Advanced Menu

Chipset Information Menu: (Advanced Menu)
This sub-menu provides information on the CPU type and BIOS version.
**Reset Configuration Data: (Advanced Menu)**
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.

**Legacy USB Support: (Advanced Menu)**
Use this menu item to enable/disable the support for Legacy Universal Serial Bus.

**Boot-time Diagnostic Screen: (Advanced Menu)**
Use this menu item to enable/disable the Boot-time Diagnostic Screen (see “The Power-On Self Test (POST)” on page 5 - 2).

**Power on Boot Beep: (Advanced Menu)**
Use this menu item to enable/disable the beep as the computer starts up.

**Battery Low Alarm Beep: (Advanced Menu)**
Use this menu item to enable/disable the battery low alarm beep.

**Total Graphics Memory: (Advanced Menu)**
Use this menu item to set the amount of system memory to be allocated for use by the internal graphics device. The default memory size allocated is 64MB, and this may be adjusted by pressing the spacebar if required.
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a Password on Boot (see over).
Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer. If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.

Fixed disk boot sector: (Security Menu)
If you choose “Write Protect” this will protect against viruses being written to the hard disk boot sector (this is not a substitute for installing an anti-virus program - see “Viruses” on page 8 - 4).
When you turn the computer on it will look for an operating system (e.g. *Windows XP*) from the devices listed in this menu, and **in this priority order**. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the **Boot priority order**. Item specific help on the right is available to help you move devices up and down the order.
Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted (flathead) screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

- Removing the Battery
- Upgrading the Hard Disk Drive
- Upgrading the Optical (CD/DVD) Device
- Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.
When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts.

You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

**Removal Warning**

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Slide the latch in the direction of the arrow.
3. Slide the latch in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 1
Battery Removal
Upgrading the Hard Disk Drive

The hard disk drive can be taken out to accommodate other 2.5” serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage” on page C-2). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Driver Installation” on page 4-2), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 - 3.
3. Remove the hard disk bay cover 4.

**Figure 6 - 2**
Hard Disk Bay & Screw

**HDD System Warning**
New HDD’s are blank. Before you begin make sure:
- You have backed up any data you want to keep from your old HDD.
- You have all the CD-ROMs and FDDs required to install your operating system and programs.
- If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.
4. Use the tab to slide the hard disk in the direction of arrow 5.
5. Lift the hard disk up in the direction of arrow 6.
6. Reverse the process to install a new hard disk drive.

Figure 6 - 3
HDD Removal
Upgrading the Optical (CD/DVD) Device

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 - 3.
3. Remove the hard disk bay cover 4.
4. Remove the screw at point 5, and use a screwdriver to carefully push out the optical device at point 6.
5. Reverse the process to install the new device.

Figure 6 - 4
Removing the CD/DVD Device
Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-DIMM) DDR II (DDR2) type memory modules (see “Memory” on page C - 2 for details of supported module types).

The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the CPU/RAM bay cover and remove screws 1 - 7.

Figure 6 - 5
CPU/RAM Bay Screws
Upgrading The Computer

3. Remove the bay cover.

4. Gently pull the two release latches on the sides of the memory socket in the direction indicated by the arrows in Figure 6 - 7.

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.

Figure 6 - 7
RAM Module Release Latches
Upgrading The Computer

5. The RAM module will pop-up, and you can remove it.

6. Pull the latches to release the second module if necessary.

7. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory slot.

8. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit without much pressure.

9. Press the module in and down towards the mainboard until the slot levers click into place to secure the module.

10. Replace the bay cover and screws.

11. Restart the computer to allow the BIOS to register the new memory configuration as it starts up.

Figure 6 - 8
RAM Module Removal
Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

Unauthorized tampering with the HDD may also violate your warranty.
Chapter 7: Modules & Options

Overview

This chapter contains information on the following modules, which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

- Wireless LAN Module
- Bluetooth Module
- PC Camera Module

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.
Wireless LAN Module

If you have included an Intel PRO/Wireless 3945ABG (802.11a/b/g) PCIe WLAN module or 802.11 b/g USB WLAN module in your purchase option, make sure that the Wireless LAN module is on (the LED will be green and the indicator will briefly be displayed when the module is powered on) before installing the driver. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Intel WLAN Driver Installation

1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click Install Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.

802.11 b/g WLAN Driver Installation

1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click Install Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Finish to complete the installation.

Note: The operating system is the default setting for Wireless LAN control in Windows Vista (see overleaf).
Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. **Click** the taskbar wireless icon , and then click **Connect to a network** (or **right-click** the icon , and then click **Connect to a network**).

2. In the **Show** list, click to choose **Wireless** from the drop-down menu.
3. A list of currently available networks will appear.

![Taskbar Menus](image)

**Figure 7 - 1**
Taskbar Menus

You can also use the **Network and Sharing Center** control panel in Windows (**Network and Internet**) to connect to any available wireless networks.

![Connect to a Network](image)

**Figure 7 - 2**
Connect to a Network
4. Click a network, and then click **Connect**.
5. If you do not see a network you want to connect to, click **Set up a connection or network** (a list of options will appear allowing manual searching, and creating a new network).

![Connecting](image1.png)

**Figure 7 - 3**
Connecting

6. Move the cursor over the taskbar icon ![Network Status](image2.png) to see the connection status (see below).

![Connection Status](image3.png)

**Figure 7 - 4**
Connection Status
7. To disconnect from the wireless network you can click the taskbar wireless icon  
, and then select **Connect or disconnect** to access the network menu, and

right-click the icon  
, and then click **Disconnect from**.

---

**Security Enabled Networks**

You should try to make sure that any network you are connecting to is a secure network.

Connecting to unsecure networks may allow unauthorized access to your computer, documents, websites and files etc.

---

**Figure 7 - 5**

Disconnecting
Windows Mobility Center

The **Windows Mobility Center** control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Double-click **Windows Mobility Center** (Mobile PC).
3. Click the button to **Turn wireless off/on**, or click the icon to access the network menu.

*Figure 7-6 Windows Mobility Center*
Bluetooth Module

If you have included a Bluetooth module in your purchase option, make sure that the optional Bluetooth module is on (the LED will be green and the indicator will briefly be displayed when the module is powered on) before installing the Bluetooth driver. Make sure you install the drivers in the order indicated in Table 4-1, on page 4-3.

Bluetooth Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click Install Option Drivers (button).
3. Click 2. Install Bluetooth Driver > Yes.
4. Choose the language you prefer, and click OK > Next.
5. Click the button to accept the license agreement, and then click Next.
6. Click Next > Install.
7. Click Finish, and the BlueSoleil icon will appear on the desktop.
8. You can configure the settings at any time by going to the IVT Corporation BlueSoleil - Main Window (Start > Programs/All Programs > IVT BlueSoleil > BlueSoleil), or by clicking the desktop icon .

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the Fn + F12 key combination to toggle power to the Bluetooth module, and check the indicator to see if the module is powered on or not (see Table 1-3, on page 1-8, Table 1-5, on page 1-11).
User Guides & Help

View the BlueSoleil User Guides from the Help Menu (or press the F1 key) in the IVT Corporation BlueSoleil - Main Window control panel.

Click the Help menu and select Contents and Index.

Look through Getting Started or select the appropriate User Guide from the Contents menu.

Figure 7 - 7
BlueSoleil Main Window & Help
PC Camera Module

If you have included a PC Camera module in your purchase option, make sure that the optional PC Camera module is on (the indicator will briefly be displayed when the module is powered on) before installing the PC Camera driver. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Taking Still Pictures

You can use the application button to take still pictures if you have installed the hot key driver. (See “PC Camera Hot Key Buttons” on page 7 - 15.)

Latest PC Camera Driver Information

Check the CD, and any accompanying insert pages for the latest updated information on the PC Camera driver, that may override the information provided here.

Adding/Removing a PC Camera

Note that the Quick Button and PC Camera drivers cannot co-exist.

If you wish to add a PC Camera module to your computer at a later date, then uninstall the Quick Button Utility Driver (entitled Multimedia Keyboard Driver) before installing the PC Camera and driver. Drivers can be uninstalled from the Add or Remove Programs control panel in Windows.

If you wish to remove a PC Camera module from your computer at a later date, then uninstall the PC Camera Driver after removing the camera module. You can then insert the Device Drivers & Utilities + User’s Manual CD-ROM and install the Quick Button Utility driver from the Drivers Installer menu.
PC Camera Driver Installation
1. Make sure the module is powered on, and then insert the *Device Drivers & Utilities + User’s Manual CD-ROM* into the CD/DVD drive.
2. Click **Install Option Drivers** (button).
3. Click **3. Install Camera Driver > Yes**.
4. Choose the language you prefer and click **Next**.
5. Click **Next**.
6. Click **Finish** to restart the computer.
7. Run the **BisonCap** application program from the **BisonCam** shortcut on the desktop, or from the **BisonCam** item in the **Start > Programs/All Programs** menu (if the hardware is turned off use the **Fn + F10** key combination to turn it on again).
8. You can use the application button ⌨️ to run the **BisonCap** application if you have installed the hot key driver (see “Hot-Key Buttons” on page 4 - 6).
9. A **Snapshot** folder will be placed on the desktop to record still pictures taken with using the application button ⌨️ (see “PC Camera Hot Key Buttons” on page 7 - 15).
PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Line-In/Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Line-In/Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Line-In/Microphone slider to the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu (or press the application button).
9. Go to the Devices menu heading and select the appropriate recording device (it should have a tick alongside it) e.g Microphone (Realtek High Definition Audio).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
Figure 7 - 8
Audio Setup for PC Camera
BisonCap

BisonCap is a video viewer useful for general purpose video viewing and testing, and can capture video files to .avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > Bison-Cam menu, or by pressing the application button (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 11) and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size (see the sidebar - Pre-Allocating File Space) for the captured file. Click Start Capture again.
4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., choose a file name and location, and then click Open (you can view the file using the Windows Media Player).

Set Capture File

In the BisonCap application you will only be asked to set the capture file name on the first run of the program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the Set Capture File., option in the File menu, and set the file name and location before capture. Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).
Eliminating Screen Flicker

If you find that the video screen in the BisonCap application is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 9
Video Capture Filter
PC Camera Hot Key Buttons
You can use the PC Camera hot key buttons (the quick button utility must NOT be installed - see “Application Quick Button” on page 4 - 7) to run the Bison-Cap program, to take still pictures and to zoom the camera in and out (if you have installed the hot key and PC Camera drivers - see “Hot-Key Buttons” on page 4 - 6 & “PC Camera Driver Installation” on page 7 - 10).

1. Make sure the PC Camera is on (use the \textbf{Fn + F10} key combination to power on the camera).
2. Press the application button once.
3. The \textbf{BisonCap} application will run.
4. Use the zoom keys to obtain the picture required.
5. Press the application button for a second time (an alert sound will indicate when the picture is being taken).
6. The picture (in JPEG format) will be placed in the \textbf{Snapshot} folder on the desktop.

\textbf{Snapshot Folder}
The Snapshot folder’s default location is on the desktop. Do not move this folder or an error may appear when you try to take a still picture using the application hot key button.

If you accidentally delete or move the folder, you can create a new Snapshot folder on the desktop in order to capture the files.
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indicators” on page 1 - 8) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8), the Fn + F4 key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness.

- **Display Choice** - Press Fn + F7 to make sure the system is not set to “external only” display.

- **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

• Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

• Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Supervisor** password for the BIOS (see “Security Menu” on page 5 - 9).

• Keep copies of vital **settings files** such as network, dialup settings, mail settings etc.(even if just brief notes).

---

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Troubleshooting

Viruses

• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Troubleshooting

Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

• Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
# Troubleshooting

## Problems and Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the power but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery LED power indicator is blinking orange.</td>
<td><em>Low Battery.</em> Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing battery power too quickly.</td>
<td><em>The system is using too much power.</em> If your OS has a Power Options scheme (see “Power Plans” on page 3 - 4/“Power Schemes” on page D - 22) check its settings. You may also be using an ExpressCard device that is drawing a lot of power.</td>
</tr>
<tr>
<td>Actual battery operating time is shorter than expected.</td>
<td><em>The battery has not been fully discharged before being recharged.</em> Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 9/ “Battery Information” on page D - 26).</td>
</tr>
<tr>
<td></td>
<td><em>Power Options have been disabled.</em> Go to the Control Panel in Windows and re-enable the options.</td>
</tr>
<tr>
<td></td>
<td><em>A peripheral device/USB device/Express Card is consuming a lot of power.</em> Turn off/remove the unused device to save power.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels too hot.</td>
<td>Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put the system into <strong>Hibernate</strong> mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 15). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan intakes to be blocked.</td>
</tr>
<tr>
<td>Nothing appears on screen.</td>
<td><strong>The system is in a power saving mode.</strong> Toggle the sleep/resume key combination, <strong>Fn + F4</strong> (see “Sleep Button” on page 3 - 6/“Sleep Button” on page D - 25). <strong>The screen controls need to be adjusted.</strong> Toggle the screen control key combinations <strong>Fn + F8/F9.</strong> If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls. <strong>The computer is set for a different display.</strong> Toggle the screen display key combination, <strong>Fn + F7.</strong> If an external monitor is connected, turn it on. <strong>The screen saver is activated.</strong> Press any key or touch the <strong>TouchPad.</strong></td>
</tr>
<tr>
<td>No image appears on the external monitor I have plugged in and powered on.</td>
<td><strong>You haven’t installed the video driver and configured it appropriately from the Control Panel.</strong> See “Intel Video Driver Installation” on page B - 1/“Video (WinXP)” on page D - 33 for instructions on installing and configuring the video driver.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause - Solution</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>You forget the <strong>boot password</strong>.</td>
<td><em>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</em></td>
</tr>
<tr>
<td>The sound cannot be heard or the volume is very low.</td>
<td><em>The volume might be set too low. Check the volume control in the Volume Control Panel in the Windows taskbar, or use the key combination Fn + F5 and F6 (see “Audio Features” on page 2-14/“Audio Features” on page D-9) to adjust.</em></td>
</tr>
<tr>
<td>The compact disc cannot be read.</td>
<td><em>The compact disc is dirty. Clean it with a CD-ROM cleaner kit.</em></td>
</tr>
<tr>
<td>The compact disc tray will not open when there is a disc in the tray.</td>
<td><em>The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2-3).</em></td>
</tr>
<tr>
<td>The DVD regional codes can no longer be changed.</td>
<td><em>The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2-5/“DVD Regional Codes” on page D-2.</em></td>
</tr>
</tbody>
</table>

---

**Password Warning**

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unwelcome numbers appear when typing.</td>
<td>If the LED ( \text{LED} ) is lit, then Num Lock is turned ON. (see “LED Indicators” on page 1 - 8).</td>
</tr>
</tbody>
</table>

### Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not work.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td>The system’s power saving features have timed-out. Use the AC/DC adapter, press the sleep (( \text{Fn} + \text{F4} )) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a power saving mode.</td>
<td>Power Options features are not enabled. Go to the Windows Power Options menu and enable the features you prefer (see “System Power Options” on page 3 - 6/“System Power Options” on page D - 23). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td>The computer stops responding during stand by or hibernation, or when you try to use the Shut Down command in Windows XP Only.</td>
<td>The computer may stop responding when you put it into (or resume from) Stand By or Hibernate, or when you shut down. This error is caused by power management within Windows XP, when applied to a PC Camera attached to the internal USB hub. Microsoft has posted a Hotfix for this error on its website (search for Hotfix KB909667). Download and install the Hotfix to correct this error.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Wireless LAN/Bluetooth modules cannot be detected.</td>
<td><em>The modules are off.</em> Check the LED indicator ((LED indicator) and/or function key indicator to see if the WLAN/Bluetooth module is on or off (see “LED Indicators” on page 1 - 8). If the LED indicator is off, then press the <strong>Fn + F11 (WLAN)</strong> or <strong>Fn + F12 (Bluetooth)</strong> key combination(s) in order to enable the modules (see “Function Keys” on page 1 - 11).</td>
</tr>
<tr>
<td>The PC Camera module cannot be detected.</td>
<td><em>The module is off.</em> Press the <strong>Fn + F10</strong> key combination in order to enable the module (see “Function Keys” on page 1 - 11). Run the <strong>BisonCap</strong> program (see “” on page 7 - 8) to view the camera picture.</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be configured.</td>
<td>The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions for the appropriate module in “Modules &amp; Options” on page 7 - 1/“Driver Installation” on page D - 30).</td>
</tr>
<tr>
<td>No visual indicators appear when using the Function Key combinations, or the audio record function does not work.</td>
<td>The hot key driver is not running/installed (the icon will not appear in the taskbar). Make sure you have installed the driver. If you do not see the icon in the taskbar you can run the program again from <strong>C:\Program Files\HotKey_Driver\HotKeyDriver.exe</strong>.</td>
</tr>
</tbody>
</table>
Troubleshooting
Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
## Interface (Ports & Jacks)

### Notebook Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader Port</td>
<td>The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device.</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>External Monitor (VGA)</td>
<td>This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or simultaneous display on the LCD and external monitor/FPD (see “Display Devices” on page B-5).</td>
</tr>
<tr>
<td>Headphone-Out Jack</td>
<td>Headphones or speakers may be connected through this jack. <strong>Note:</strong> Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Line-In Jack</td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers.</td>
</tr>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mini-IEEE 1394 Port</strong></td>
<td>This port allows a high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras <em>(see note below)</em>. The Mini-IEEE 1394 port only supports <strong>SELF POWERED</strong> IEEE 1394 devices.</td>
</tr>
<tr>
<td><strong>RJ-11 Modem Jack</strong></td>
<td>This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection. <strong>Note:</strong> Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td><strong>RJ-45 LAN Jack</strong></td>
<td>This port supports LAN (Network) functions. <strong>Note:</strong> Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td><strong>Security Lock Slot</strong></td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
<tr>
<td><strong>Serial Port</strong></td>
<td>Connect a serial type mouse to this port.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S/PDIF-Out Jack</td>
<td>This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.</td>
</tr>
<tr>
<td>7-Pin S-Video-Out Jack</td>
<td>Connect your television to your computer and view DVDs, VCDs or anything else your computer can display.</td>
</tr>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
Appendix B: Intel Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 17.

Intel Video Driver Installation

Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 3. Instructions for installing the video driver are repeated below.

Video (VGA)

1. Click 2. Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much (up to 224MB) system memory (RAM) as needed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system. To adjust the total video memory used by the computer (Pre-Allocated + Fixed + DVMT) see “Total Graphics Memory: (Advanced Menu)” on page 5 - 8.
Intel Video Driver Controls

Taskbar Icon
The Intel GMA control panel can also be accessed by clicking the icon in the taskbar and selecting Graphics Properties from the menu.

If you cannot see the tray icon click the “Show Tray Icon” tickbox in the Intel(R) Graphics Media Accelerator for Mobile tab.

Figure B - 1
Intel Graphics Properties

Intel Graphics Properties
More advanced video configuration options are provided by the Intel(R) Graphics Media Accelerator Driver for Mobile.

1. Open the Display Settings (Personalization) control panel (see “Video Features” on page 1 - 17) and click Advanced Settings (button).
2. Click the Intel(R)... tab and click Graphics Properties (button).
You may make changes to the devices, color, schemes, **Hot Keys** etc. by clicking the appropriate menu item or button. Click **Information** (button) to obtain useful information about the graphics properties of the computer, and see the **Support** tab in **Information** to get weblinks to the latest information on the Intel Website.

---

**Help Menus**

Right-click on many of the items in the tabs to bring up the “What’s This?” button.

Click the “What’s This?” button to bring up the help menu.

**Multiple Display**

At least one other display must be attached in order to view **Multiple Display** options.

---

*Figure B - 2*

**Intel Graphics Media Accelerator Driver**

*for mobile*

(Control Panel Tabs)
Intel Video Driver Controls

**Scheme Options**

Use Scheme Options to configure quick settings for applications which require specific resolution and color settings in order to run properly e.g. games, multimedia programs. To set the scheme options:

1. Open the Display Settings control panel and click Advanced Settings (button).
2. Click the Intel(R)... tab and click Graphics Properties (button).
3. Configure your display configuration, resolution etc. as per your requirements from Display Settings.
4. Click on Scheme Options (button).
5. Type a name for the scheme (then click Save or see below).
6. If you want to automatically launch an application when running the scheme click on Browse (button).
7. Browse to the executable file for the application you want to set the scheme for (see sidebar), and click Open to select it.
8. Click Save to save the settings (you can click in the "Restore the display settings after exiting this application" box to return to your original settings when you exit the program).
9. Click OK to exit the window.
10. You can run the scheme by clicking the taskbar icon and selecting the scheme from Select Scheme.

---

**Application.exe**

You will need to locate the actual application executable (.exe) file, not just the shortcut. To find the application right-click its shortcut on the desktop click Properties. Click the Shortcut (tab) and see where the executable file is located by clicking the Open File Location (button). Note the location and you will then be able to browse to this file.

---

**Figure B - 3**

Select Scheme
Display Devices

Besides the built-in LCD, you can also use an external monitor/flat panel display or TV as your display device. The following are the display options:

1. The built-in LCD.
2. An external monitor connected to the external monitor port.
3. A flat panel display connected to the external monitor port.
4. A TV connected to the S-Video-Out Jack.

Switching Modes When Using the Power DVD Application

Switch display modes before playing any DVD in the Power DVD Application; it is not possible to switch display modes while a DVD is playing (you will be required to stop the DVD playing, switch display modes, then start the DVD playing again).

Function Key Combination

You can use the $\text{Fn} + \text{F7}$ key combination to toggle through the display options:

- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.
Attaching Other Displays

If you prefer to use a monitor or flat panel display, connect it to the external monitor port at the rear of the computer.

Windows Vista
1. Attach your external display to the external monitor port (or TV to the S-Video-Out Jack), and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click on any of the buttons to configure the displays to your preference, or click Display Settings to access the control panel.
Intel® GMA Driver for Mobile

1. Go to the Intel Graphics Properties control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
2. Click to choose the display option from the Multiple Display menu.
3. Click Apply (and OK to confirm the settings change) and OK (button).

Figure B - 5
Display Devices
Display Modes

Single Display
Only one of your attached displays is used.

Intel(R) Dual Display Clone (mirrored)
This mode will drive multiple displays with the same content. Each device may be configured independently for different resolutions, refresh rates, color quality etc. Use this feature to display the screen through a projector for a presentation.

Extended Desktop (extended)
This mode allows a desktop to span multiple displays and acts as a large workspace. This creates a lot more screen area for display. Use Display Devices (Intel GMA for Mobile - Figure B - 7 on page B - 10) control panel to drag the monitors to match the physical arrangement you wish to use, or you may also use Display Settings (Windows control panel - Figure B - 9 on page B - 12) to configure the relative size and position.
To Enable Intel(R) Dual Display Clone
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out Jack), and turn it on.
2. Go to the Intel Graphics Properties control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
3. Click to choose Intel(R) Dual Display Clone (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.
To Enable Extended Desktop
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out Jack), and turn it on.
2. Go to the Intel Graphics Properties control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
3. Click to choose Extended Desktop (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Display Settings
Extended Desktop
You can have different Colors, Screen Area and Monitor Refresh Rates for each display device provided your monitor can support them.

You can drag the monitor icons to match the physical layout of your displays. Icons and programs may also be dragged between the displays.

Figure B - 7
Extended Desktop Mode

Click the appropriate monitor icon and drag it to match the physical arrangement you wish to use (e.g. the secondary display may be extended left/right/above/below the primary display).

Click Display Settings to make any adjustments required.
Using New Display Detected to Enable Extended Mode
1. Attach your external display to the external monitor port (or TV to the S-Video-Out Jack), and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Display Settings
Extended Desktop

Use the control panel to drag the monitors to match the physical arrangement you wish to use.

You can drag any icons or windows across to either display desktop, which makes it possible to have one program visible in one of the displays, and a different program visible in the other display.

Figure B - 8
New Display Detected
(Extended)
Using Display Settings to Enable Extended Mode
1. Attach your external display to the external monitor port (or TV to the S-Video-Out Jack), and turn it on.
2. Open the Display Settings control panel (see “Video Features” on page 1 - 17).
3. Click the monitor icon (e.g. 2), and make sure you have checked “Extend the desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary Display 1 is on the left, the Secondary Display 2 is on the right.
TV Settings

If you are using a TV as a display device adjust the display settings as follows:

1. Use an S-Video cable to connect your TV to the S-Video-Out Jack and turn it on.
2. Go to the Intel Graphics Properties control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
3. Click to choose either Single Display or Multiple Display.
4. Choose the television as your display device (Single Display), or as one of your display devices (Multiple Display).
5. Click Apply, and OK to confirm the settings change.

Function Key Combination

You can use the Fn + F7 key combination to toggle through the display options:

- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.

Figure B - 10
Display Devices with TV
6. Click **Display Settings** to adjust the settings for the television.
7. Choose the appropriate TV system from **Video Standard** dropbox.
8. Click the **TV Settings** (button) to make any video adjustments for the television.

**Figure B - 11**
TV Settings
## Appendix C: Specifications

### Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, delayed or updated due to the manufacturer’s release schedule. Check with your service center for details.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor</strong></td>
<td></td>
</tr>
<tr>
<td>Intel® Core™2 Duo Processor (478-pin) Micro-FC-PGA Package</td>
<td>65nm (65 Nanometer) Process Technology</td>
</tr>
<tr>
<td>T7200/ T7400/ T7600</td>
<td>4MB On-die L2 Cache &amp; 667MHz FSB</td>
</tr>
<tr>
<td>T5500/ T5600</td>
<td>2.0/ 2.16/ 2.33 GHz</td>
</tr>
<tr>
<td>T2300/ T2400/ T2500/ T2600</td>
<td>65nm (65 Nanometer) Process Technology</td>
</tr>
<tr>
<td></td>
<td>2MB On-die L2 Cache &amp; 667MHz FSB</td>
</tr>
<tr>
<td></td>
<td>1.66/ 1.83 GHz</td>
</tr>
<tr>
<td>Intel® Celeron® M Processor (478-pin) Micro-FCPGA Package</td>
<td>65nm (65 Nanometer) Process Technology</td>
</tr>
<tr>
<td>420/ 430/ 440/ 450</td>
<td>1MB On-die L2 Cache &amp; 533MHz FSB</td>
</tr>
<tr>
<td></td>
<td>1.60/ 1.73/ 1.86/ 2.0 GHz</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Logic</td>
<td>Intel 945GM + ICH7-M</td>
</tr>
<tr>
<td>Memory</td>
<td>Two 200 Pin SO-DIMM Sockets Supporting DDR2 533/667 MHz 64-bit Wide DDRII (DDR2) Data Channel Memory Expandable up to 2GB (256/ 512/ 1024 MB DDRII Modules) (Note: Do Not Use Other Module Types)</td>
</tr>
<tr>
<td>Video Adapter</td>
<td>Intel 945GM Integration Dynamic Video Memory Technology DVMT - Supports up to 224MB of Video Memory (dynamically allocated from system memory where needed) Integrated High Quality 3D Graphics Engine Accelerator Supports Two Displays in Dual View</td>
</tr>
<tr>
<td>Security</td>
<td>Security (Kensington® Type) Lock Slot BIOS Password</td>
</tr>
<tr>
<td>BIOS</td>
<td>One 512KB Flash ROM Phoenix™ BIOS</td>
</tr>
<tr>
<td>LCD</td>
<td>15.4&quot; - 16:10 Wide Screen WXGA; WSXGA+</td>
</tr>
<tr>
<td>Storage</td>
<td>One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page C - 5 for drive options) Easy Changeable 2.5&quot; 9.5 mm (h) HDD with SATA (Serial) Interface</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Audio</strong></td>
<td>Integrated AZALIA Compliant Interface (HDA)</td>
</tr>
<tr>
<td></td>
<td>3D Stereo Enhanced Sound System</td>
</tr>
<tr>
<td></td>
<td>Sound-Blaster PRO™ Compatible</td>
</tr>
<tr>
<td></td>
<td>2 * Built-In Speakers</td>
</tr>
<tr>
<td></td>
<td>Built-In Microphone</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: External 7.1 CH Audio Output Support Configurable Through Headphone-Out, Microphone-In, Line-In and S/PDIF Out Jacks</td>
</tr>
<tr>
<td><strong>Keyboard &amp; Pointing Device</strong></td>
<td>Winkey Keyboard</td>
</tr>
<tr>
<td></td>
<td>Built-In TouchPad with Scrolling Function</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>Three USB 2.0 Ports</td>
</tr>
<tr>
<td></td>
<td>One Serial Port</td>
</tr>
<tr>
<td></td>
<td>One External Monitor Port</td>
</tr>
<tr>
<td></td>
<td>One Headphone-Out Jack</td>
</tr>
<tr>
<td></td>
<td>One Microphone-In Jack</td>
</tr>
<tr>
<td></td>
<td>One Line-In Jack</td>
</tr>
<tr>
<td></td>
<td>One S/PDIF Out Jack</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: External 7.1 CH Audio Output Support Configurable Through Headphone-Out, Microphone-In, Line-In and S/PDIF Out Jacks</td>
</tr>
<tr>
<td><strong>Card Reader</strong></td>
<td>Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: MS Duo/ Mini SD/ RS MMC Cards require a PC adapter</td>
</tr>
<tr>
<td><strong>ExpressCard Slot</strong></td>
<td>ExpressCard/54 (34)Slot</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication</strong></td>
<td>AZALIA 56K Plug &amp; Play Fax/Modem v1.5 Compliant</td>
</tr>
<tr>
<td></td>
<td>10/ 100/ 1000 PCIe Fast Ethernet LAN</td>
</tr>
<tr>
<td></td>
<td>USB Bluetooth V2.0 + EDR Module (Factory Option)</td>
</tr>
<tr>
<td></td>
<td>1.3M Pixel USB PC Camera Module (Factory Option)</td>
</tr>
<tr>
<td><strong>Wireless Module Options:</strong></td>
<td>Intel PRO/Wireless 3945ABG PCIe Wireless LAN Module</td>
</tr>
<tr>
<td></td>
<td>802.11 b/g USB Wireless LAN Module</td>
</tr>
<tr>
<td><strong>Power Management</strong></td>
<td>Supports ACPI 3.0</td>
</tr>
<tr>
<td></td>
<td>Supports Suspend to RAM (S3)</td>
</tr>
<tr>
<td></td>
<td>Supports Suspend to Disk (S4)</td>
</tr>
<tr>
<td></td>
<td>Supports Soft Off (S5)</td>
</tr>
<tr>
<td></td>
<td>Battery Low Suspend</td>
</tr>
<tr>
<td></td>
<td>Supports Resume from Modem Ring</td>
</tr>
<tr>
<td></td>
<td>Supports Wake on LAN</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz / DC Output 19V, 3.42A (65W)</td>
</tr>
<tr>
<td><strong>Battery</strong></td>
<td><strong>For Model A Computers Only</strong></td>
</tr>
<tr>
<td></td>
<td>6 Cell Smart Lithium-Ion Battery Pack, 4400mAh (48.8W)</td>
</tr>
<tr>
<td><strong>For Model B Computers Only</strong></td>
<td>6 Cell Smart Lithium-Ion Battery Pack, 4000mAh (44.4W)</td>
</tr>
<tr>
<td><strong>Environmental Spec</strong></td>
<td>Operating: 5°C ~ 35°C</td>
</tr>
<tr>
<td></td>
<td>Non-Operating: -20°C ~ 60°C</td>
</tr>
<tr>
<td><strong>Relative Humidity</strong></td>
<td>Operating: 20% ~ 80%</td>
</tr>
<tr>
<td></td>
<td>Non-Operating: 10% ~ 90%</td>
</tr>
<tr>
<td><strong>Dimensions &amp; Weight</strong></td>
<td>360mm (w) * 267mm (d) * 25.4-34mm (h)</td>
</tr>
<tr>
<td></td>
<td>2.6 kg With 6 Cell Battery and DVD-ROM</td>
</tr>
</tbody>
</table>

**C - 4 Specifications**
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
</table>
| Optional                     | **Optical Drive Module Options:**  
DVD/CD-RW Combo Drive Module  
DVD-Dual Drive Module  
DVD-Super Multi Drive Module  
USB Floppy Disk Drive *(Factory Option)* | Intel PRO/Wireless 3945ABG PCIe Wireless LAN Module  
802.11 b/g USB Wireless LAN Module  
6 Cell Smart Lithium-Ion Battery Pack  
1.3M Pixel USB PC Camera Module *(Factory Option)*  
USB Bluetooth V2.0 + EDR Module *(Factory Option)* |
Appendix D: Windows XP Information

This Appendix contains information (including control panel information, driver installation etc.) for users of the *Windows XP OS*. 
DVD Regional Codes

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

Table D - 1 - DVD Region Codes
Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View.
Function Keys/Hot Keys

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the basic function key combinations; visual indicators are available when the hot key driver is installed (see “Hot Key (WinXP)” on page D - 34). After installing the driver an icon will appear in the taskbar.

Double-click the icon to bring up the configuration menu to set the time for the visual indicators to be displayed on screen. Click OK to minimize the program (if you click the close icon see the sidebar).

The hot key buttons on the left side of the computer give quick access to the default internet browser and e-mail program. The PC Camera hot key buttons can be used to run the application, to take still pictures and to zoom the camera in/out (see “PC Camera Hot Key Buttons” on page D - 43) if a PC Camera module is installed. If you do not have a PC Camera module installed see “Application Quick Buttons” on page D - 8 for details.
<table>
<thead>
<tr>
<th>Fn/Hot Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + F1</td>
<td>TouchPad Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
</tr>
<tr>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td></td>
<td>Activate BisonCap Program/ Take Still Picture</td>
</tr>
<tr>
<td></td>
<td>Audio Record Start/Stop (see over)</td>
</tr>
</tbody>
</table>

*Table D - 2 - Hot Key Functions & Indicators*
Recording Audio

The [ ] audio record hot key button allows you to record audio (the hot key program must be running - see sidebar) from either the built-in microphone, or from a microphone connected to the microphone-in jack. To record on the computer, setup the audio recording options in *Windows* as follows (see *Figure D - 4 on page D - 7*).

1. Go to the *Start* menu and point to *Settings* (or just click *Control Panel*) and click *Control Panel*, then double-click the *Sounds & Audio Devices* icon (*Sounds*, *Speech, and Audio Devices* in Category View).
2. Click *Advanced* in the *Volume > Device volume* tab.
3. Click *Options* and scroll down and click *Properties*.
4. Select *Realtek HD Audio input* from the *Mixer device* menu.
5. Click *Mic Volume* (check box) if it is not checked, then click *OK*.
6. Make sure the *Select* (check box) in the *Recording Control* panel, under the *Mic Volume* section, is checked (boost the volume as high as it will go).
7. Close the *Recording Control* window, and then click *OK*.
8. Press the [ ] audio record hot key button to begin the recording process (the record icon will flash in the top left of the screen).
9. Press the [ ] audio record hot key button again to stop the recording process (the record icon will disappear in the top left of the screen).
10. The recorded audio file (in .wav format) will appear in the *Shared Documents > Wav* folder in *My Computer*.
11. Double-click the file to playback the recorded audio.

---

*Hot Key Program*

The audio record function will only run if the program is running (i.e. the icon is displayed in the taskbar). If you have closed the program you can run it again from C:\Program Files\HotKey_Drivers\HotKeyDriver.exe.
Figure D - 4
Audio Setup for Recording (Windows XP)
Application Quick Buttons

Note that the quick button driver is designed to allow use of the hot key buttons in absence of the optional PC Camera (only install the quick button driver if the PC Camera is not installed). You will need to install the Application Quick Button driver (see “Application Quick Button (WinXP)” on page D - 34) to enable the functions.

The quick buttons give instant access to user-defined applications, with one quick button press. To configure a program to open when the hot-keys are pressed follow the instructions below. The quick buttons will function as long as the program is running (the icon will appear in the taskbar). If the program is not running you will need to restart the computer.

1. Press a hot key or right-click the icon in the taskbar.
2. Select Setup from the menu, scroll to App1/2/3 and select Custom.
3. An Open dialog box will appear on the screen.
4. Browse to the directory where the desired application.exe (see sidebar) program exists.
5. Double-Click on the program file or choose Open.

Figure D - 5
Hot-Key Configuration Screens
Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices icon in the Windows control panel, or from the Realtek HD Audio Manager icon in the taskbar/control panel (this will bring up the Realtek Audio Configuration menus). The volume may also be adjusted by means of the Fn + F5/F6 key combination.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows (and the volume control function keys on the computer). Click the Volume icon on the taskbar to check the setting.

Figure D - 6 - Realtek Audio Configuration Menus
8 Channel Sound Support

If you wish to configure your system for 8 channel sound support, then the following ports should be used as outputs. Connect the system cables to the following audio jacks:

- Side Speaker Out - Connect to S/PDIF Out
- Center/Subwoofer Speaker Out - Connect to Microphone In
- Front Speaker Out - Connect to Speaker/Headphone Out
- Rear Speaker Out - Connect to Line In

**Figure D - 7 - 8 Channel Sound Support**

8 Channel Sound Support

Double-click the Realtek HD Audio Manager icon in the taskbar to bring up the Realtek control panel.

Click Audio I/O (tab).

Select 8CH Speaker from the pull-down menu.

Click OK to save.

Connect the cables to the audio jacks as outlined.
TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse.

Configuring the TouchPad and Buttons

Once you have installed the TouchPad driver you can configure the functions by double-clicking the TouchPad driver icon in the taskbar, or by going to the Mouse control panel in Windows (Start menu and point to Settings and click Control Panel, then double-click the Mouse icon). In Windows XP the Mouse control panel is in the Printers and Other Hardware Category.

Mouse Driver

If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device’s user documentation for details.

Figure D - 8
Mouse Properties
Windows XP Information

Video Features

Your computer has built-in Intel (Intel 945GM) video. You can switch display devices, and configure display options, from the Display Properties control panel in Windows as long as the appropriate video driver is installed.

To access Display Properties in Windows:

1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution (Figure D - 9 on page D - 13).
5. Click the arrow, and scroll to the preferred setting in Color quality (Figure D - 9 on page D - 13).
6. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button) (Figure D - 9 on page D - 13) to bring up the Advanced properties tabs.
8. Click the Intel(R) Graphics Media Accelerator Driver for Mobile tab, and click Graphics Properties (button) to make any video adjustments you require.
9. You can also access Graphics Properties from the Windows Intel(R) GMA Driver for Mobile control panel, or from the taskbar icon.

Dynamic Video Memory Technology

Intel® DVMT 3.0 automatically and dynamically allocates as much (up to 224MB) system memory (RAM) as needed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system.
Taskbar Icon

You can also access the controller properties from the taskbar. Click on the icon to bring up the menu and scroll to Graphics Properties.

If you cannot see the tray icon go to the Intel(R) Graphics Media Accelerator Driver for Mobile tab and click the "Show Tray Icon" tickbox. Alternatively right-click the desktop and select Graphics Options > Tray Icon > Enable.
Windows XP Information

You may make changes to the devices, color, schemes, **Hot Keys** etc. by clicking the appropriate menu item or button. Click **Information** (button) to obtain useful information about the graphics properties of the computer, and see the **Support** tab in **Information** to get weblinks to the latest information on the Intel Website.

**Function Key Combination**

You can use the **Fn + F7** key combination to toggle through the display options:

- Notebook Only
- External Display Only
- TV
- Notebook + External Display

Make sure you give the displays enough time to refresh.

**Intel Display Note**

Note that the notebook is the default Primary display device and may not be changed.

![Figure D - 10 - Intel GMA Driver for Mobile](image)

**D - 14 Video Features**
Display Devices & Options
Besides the built-in LCD, you can also use an **external VGA monitor (CRT)/external Flat Panel Display** or **TV** as your display device. A VGA monitor/Flat Panel Display connects to the external monitor port, a TV to the S-Video-Out jack. The following display modes are available.

<table>
<thead>
<tr>
<th>Intel Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Mode</td>
<td>One of the connected displays is used as the display device</td>
</tr>
<tr>
<td>Intel(R) Dual Display Clone Mode</td>
<td>Both connected displays output the same view and may be configured independently</td>
</tr>
<tr>
<td>Extended Desktop Mode</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

*Switching Modes When Using the Power DVD Application*

Switch display modes **before playing** any DVD in the **Power DVD Application** it is not be possible to switch display modes while a DVD is playing (you will be required to stop the DVD playing, switch display modes, then start the DVD playing again).
Windows XP Information

Attaching Other Displays

If you prefer to use a monitor or flat panel display, connect it to the external monitor port at the rear of the computer.

1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out jack), and turn it on.
2. Go to the Graphics Properties control panel and click Display Devices.
3. Click to choose the display option from the Multiple Display menu.
4. Click Apply (and OK to confirm the settings change) and OK (button).

![Figure D - 11 - Display Devices](image_url)
To Enable Intel(R) Dual Display Clone Mode
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out jack), and turn it on.
2. Go to the Graphics Properties control panel and click Display Devices.
3. Click to choose Intel(R) Dual Display Clone.
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

![Display Devices & Settings]

Figure D - 12 - Display Devices & Settings
To Enable Extended Desktop Mode:
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out jack), and turn it on.
2. Go to the Graphics Properties control panel and click Display Devices.
3. Click to choose Extended Desktop.
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

![Figure D - 13 - Desktop Mode](image)

Click the appropriate monitor icon and drag it to match the physical arrangement you wish to use (e.g. the secondary display may be extended left/right/above/below the primary display).

Click Display Settings to make any adjustments required.
To Enable Extended Desktop (Display Properties)

1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out jack), and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View choose Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. 2), and make sure you have checked “Extend my Windows desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary monitor 1 is on the left, the secondary display 2 is on the right.

![Display Properties (Extended Desktop)](image)

**Figure D - 14 - Display Properties (Extended Desktop)**
Windows XP Information

TV Settings

If you are using a TV as a display device adjust the display settings as follows:

1. Attach your TV to the S-Video-Out jack and turn it on.
2. Go to the Graphics Properties control panel and click Display Devices.
3. Choose the television as one of your display devices.
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings and click Television (tab).
6. Choose the appropriate TV system from Video Standard dropbox.
7. Click TV Settings (button) to make any further adjustments supported by your television.

Figure D - 15 - TV Settings
Power Settings

Click the **Power Settings** button in **Display Settings** (tab) to set the display options based on power status of the computer.

**Intel Display Power Saving Technology**

If this option is enabled, the system will adjust LCD brightness and contrast in order to save power (when the notebook LCD is the only display device and the system is battery powered).

**Intel Dual-Frequency Graphics Technology**

If this option is enabled, the system will adjust the output frequency of the graphics adapter in order to save power (when the notebook LCD is the only display device and the system is battery powered).

![Figure D - 16 - Power Settings](image)
Power Management Features

The Power Options control panel icon in Windows (see page D - 3) allows you to configure power management features for your computer. You may conserve power through individual components such as the monitor or hard disk, or you may use either Stand by or Hibernate mode to conserve power throughout the system.

Power Schemes

You can set your computer to conserve power through individual components by means of Power Schemes. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter Stand by or Hibernate modes.

Resuming Operation

Press the Sleep/Resume key combination (Fn + F4), or power button to resume from Monitor or Hard Disk Stand by.

Figure D - 17 - Power Schemes
Each *Windows Power Scheme* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose the *Home/Office Desk* scheme for maximum performance when the computer is powered from an AC power source. Choose the *Max Battery* scheme (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered. *Windows* will use *Portable/Laptop* as the default scheme.

**System Power Options**

You can use the system power options to stop the computer’s operation and restart where you left off. This system features *Stand by* and *Hibernate* sleep mode levels (*Hibernate* mode will need to be enabled by clicking the option in the *Hibernate* tab in the *Power Options* control panel).

**Hibernate Mode vs. Shutdown**

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

**Stand by Mode vs. Hibernate Mode**

If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hibernation. It takes a longer time to wake up the system from *Hibernate* mode than from *Stand by* mode.
Windows XP Information

Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Stand by mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

Figure D - 18 - Enable Hibernation

D - 24 Power Management Features
Configuring the Power Button

The power button may be set to send the computer into either Stand by or Hibernate mode. In Stand by mode, the LED will blink green. In Hibernate mode the LED will be off (battery) or orange (AC/DC adapter). If you are in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

You may also configure the Sleep/Resume key combination (Fn + F4). In Windows this is referred to as the Sleep button.

*Figure D - 19 - Power Options (Advanced - Power Buttons)*
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

**New Battery**
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 29).

**Battery Life**
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. **Power Options** (you may set low battery **Alarms** and actions, and check the **Power Meter** from the **Power Options** control panel), and settings in the OS will help prolong the battery life if configured appropriately.

![Power Options](image)

**Figure D - 20 - Power Options (Alarm & Power Meter)**

**Low Battery Warning**
When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 8 for information on the battery charge status, and to “Battery Information” on page D - 26 for more information on how to maintain and properly recharge the battery pack.)

Conserving Battery Power
To conserve battery power:
Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
Close modem or communication applications when they are not being used.
Remove any unused Express Cards from the computer (Express Cards quickly use up battery power even if the system enters sleep mode).
Disconnect any unnecessary external devices.
Windows XP Information

Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own. Disable the **Power Options** functions in the **Control Panel**, especially any **Alarms** (unclick the tickboxes - see page *D - 26*) and **Schemes** (change all the settings to **Never** - see page *D - 22*). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

---

**Caution**

Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Driver Installation

The *Device Drivers & Utilities + User’s Manual CD-ROM* contains the drivers and utilities necessary for the proper operation of the computer. *Table D - 4* lists what you need to install, and it is very important that the drivers are installed in the order indicated.

Only install drivers for modules (WLAN, Bluetooth, and PC Camera) included in your purchase option.

Installation Methods (Win XP)
You may choose to install the drivers from the *autorun program*, or install them manually.

Manual Driver Installation
Click the *Browse CD* button in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.

<table>
<thead>
<tr>
<th>WinXP SP2 Driver</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the appropriate Service Pack for WinXP</td>
<td>D - 32</td>
</tr>
<tr>
<td>Chipset</td>
<td>D - 33</td>
</tr>
<tr>
<td>Video</td>
<td>D - 33</td>
</tr>
<tr>
<td>Audio</td>
<td>D - 33</td>
</tr>
<tr>
<td>LAN</td>
<td>D - 33</td>
</tr>
<tr>
<td>Modem</td>
<td>D - 33</td>
</tr>
<tr>
<td>TouchPad</td>
<td>D - 33</td>
</tr>
<tr>
<td>Express Card/Card Reader</td>
<td>D - 33</td>
</tr>
<tr>
<td>Hot Key</td>
<td>D - 34</td>
</tr>
<tr>
<td>Application Quick Button (Only appears if no PC Camera module is installed)</td>
<td>D - 34</td>
</tr>
<tr>
<td>Bluetooth <em>(Optional)</em></td>
<td>D - 35</td>
</tr>
<tr>
<td>PC Camera <em>(Optional)</em></td>
<td>D - 38</td>
</tr>
<tr>
<td>Wireless LAN <em>(Optional)</em></td>
<td>D - 44 or D - 46</td>
</tr>
</tbody>
</table>

*Table D - 4 - Driver Installation*
Drivers Installer Application
Insert the Device Drivers & Utilities + User's Manual CD-ROM (WinXP) and click Install WinXP Drivers (button), or Install Options Drivers (button) to access the Optional driver menu.

1. Check the driver installation order from Table D - 4 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out (if you need to reinstall any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure D - 21 - Drivers Installer Screen 1

Figure D - 22 - Drivers Installer Screen 2
**Windows XP Information**

**Updating/Reinstalling Individual Drivers**

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the **Control Panel** in the *Windows OS* and double-click the **Add/Remove Programs** item. If you see the **individual driver listed** (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the **Add/Remove Programs** item:

1. Click **Start** (menu), point to **Settings** and click **Control Panel** (or click **Start > Control Panel**).
2. Double-click **System** (icon); System (icon) is in **Performance and Maintenance** (category).
3. Click **Hardware** (tab) > **Device Manager** (button).
4. Double-click the **device** you wish to update/reinstall the driver for (you may need to click “+”).
5. Look for the **Update Driver** button (check the **Driver** tab) and follow the on screen prompts.

---

**Windows XP Service Pack 2**

Make sure you install *Windows XP Service Pack 2* (or a Windows XP version which includes Service Pack 2) **before installing any drivers**. Service Pack 2 includes support for USB 2.0.

If you have upgraded the system by installing **Service Pack 2** (i.e. your Windows XP version does not include Service Pack 2) then follow these instructions:

1. Click **Start** (menu), point to **Settings** and click **Control Panel** (or click **Control Panel**).
2. Double-click **System** (icon); System (icon) is in **Performance and Maintenance** (category).
3. Click the **Hardware** (tab) > **Device Manager** (button).
4. Click “+” next to **Other Devices** (if its sub-items are not shown).
5. Right-click **Universal Serial Bus (USB) Controller** and select **Uninstall > OK** (if you don’t see the item then there is no need to take any further action).
6. Restart the computer and it will find the USB 2.0 controller.
Chipset (WinXP)
1. Click **1. Install Chipset Driver > Yes.**
2. Click **Next > Yes > Next.**
3. Click **Finish** to restart the computer.

Video (WinXP)
1. Click **2. Install Video Driver > Yes.**
2. Click **Next > Yes > Next > Next.**
3. Click **Finish** to restart the computer.

Audio (WinXP)
1. Click **3. Install Audio Driver > Yes.**
2. Click **Next.**
3. Click **Finish** to restart the computer.

LAN (WinXP)
1. Click **4. Install LAN Driver > Yes.**
2. Click **Next > Install.**
3. Click **Finish.**
4. The network settings can now be configured.

Modem (WinXP)
1. Click **5. Install Modem Driver > Yes.**
2. Click **OK.**
3. The modem is ready for dial-up configuration.
4. Be sure to check if the modem country selection is appropriate for you.

TouchPad (WinXP)
1. Click **6. Install TouchPad Driver > Yes.**
2. Click **Next > Next.**
3. Click **Finish** to restart the computer.

ExpressCard/Card Reader (WinXP)
1. Click **7. Install CardReader Driver > Yes.**
2. Click **Next.**
3. Click to accept the license and click **Next.**
4. Click **Finish.**
Windows XP Information

Hot Key (WinXP)
1. Click 8. Install Hotkey Utility > Yes.
2. Click Next > Install > Finish.
3. Click Finish to restart your computer.

Application Quick Button (WinXP)
If you do not have a PC Camera module installed, then the Quick Button Driver will appear in the Driver Installation menu (only install the quick button driver if the PC Camera is not installed).

2. Click Next.
3. Click Finish to restart your computer.

Adding/Removing a PC Camera
Note that the Quick Button and PC Camera drivers cannot co-exist.

If you wish to add a PC Camera module to your computer at a later date, then uninstall the Quick Button Driver (entitled Multimedia Keyboard Driver) before installing the PC Camera and driver. Drivers can be uninstalled from the Add or Remove Programs control panel in Windows.

If you wish to remove a PC Camera module from your computer at a later date, then uninstall the PC Camera Driver after removing the camera module. You can then insert the Device Drivers & Utilities + User’s Manual CD-ROM and install the Quick Button driver from the Driver Installation menu.
Bluetooth Module

If you have included a Bluetooth module in your purchase option, make sure that the optional Bluetooth module is on (the LED will be green and the indicator will briefly be displayed when the module is powered on) before installing the Bluetooth driver. Make sure you install the drivers in the order indicated in Table D - 4, on page D - 30.

Bluetooth Driver Installation

1. Press the Fn + F12 key combination to power on the Bluetooth module.
3. Click Install Options Drivers.
4. Click 1. Install Bluetooth Driver > Yes.
5. Click Install Drivers and Application Software.
6. Choose the language you prefer, and click OK.
7. Click Next.
8. Click the button to accept the license agreement, then click Next.
9. Click Next > Next > Install.
10. Click Finish.
11. The IVT Corporation BlueSoleil - Main Window screen appears on restart.
12. You can configure the settings at any time by going to the IVT Corporation BlueSoleil - Main Window control panel (Start > Programs/All Programs > IVT BlueSoleil), or by clicking the taskbar icon .
User Guide

View the BlueSoleil User Guides from the Help Menu (or press the F1 key) in the IVT Corporation BlueSoleil - Main Window control panel. Click BlueSoleil User Guides in the Contents tab, and click to select the appropriate User Guide from the panel on the right.

Figure D - 23
Bluetooth Control Panel & User Guides

D - 36 Bluetooth Module
PC Camera

Before installing the PC Camera driver, make sure that the optional PC Camera is on. **Use the Fn + F10 key combination** (see “Function Keys” on page 1 - 10) to toggle power to the PC Camera module. Make sure you install the drivers in the order indicated in *Table D - 4, on page D - 30.*

**Stand by/Hibernate or Shutdown Error**

The computer may stop responding when you put it into (or resume from) Stand By or Hibernate, or when you shut down.

This error is caused by power management within Windows XP, when applied to a PC Camera attached to the internal USB hub.

Microsoft has posted a Hotfix for this error on its website (search for Hotfix KB909667).

Download and install the Hotfix to correct this error.

**Latest PC Camera Driver Information**

Check the PC Camera CD, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.

**Adding/Removing a PC Camera**

Note that the Quick Button and PC Camera drivers cannot co-exist. If you wish to add/remove a PC Camera module to/from your computer at a later date, then see “Adding/Removing a PC Camera” on page D - 34 for details on removing and installing the appropriate drivers.
PC Camera Driver Installation

1. Press the \texttt{Fn + F10} key combination to power on the PC Camera module.
3. Click \textit{Install Options Drivers}.
4. Click \textit{2. Install CCD Driver > Yes}.
5. Choose the language you prefer and click \textit{OK}.
6. Click \textit{Next > Finish} to restart the computer.
7. Run the \texttt{BisonCap} application program from the \texttt{BisonCam} shortcut on the desktop or from the \texttt{BisonCam} item in the \texttt{Start > Programs/All Programs} menu (if the hardware is turned off use the \texttt{Fn + F10} key combination to turn it on again).
8. You can use the application hot key \texttt{F10} to run the \texttt{BisonCap} application if you have installed the hot key driver (\textit{“Hot Key (WinXP)” on page D - 34}).
9. A \texttt{Snapshot} folder will be placed on the desktop to record still pictures taken by using the application hot key \texttt{F10}.

---

\textbf{Taking Still Pictures}

Double-click the \texttt{My Computer} icon on the desktop, or go the \texttt{Start} menu and point to \texttt{My Computer}, then click it.

Double-click the \texttt{Bison-Cam, NB Pro} icon.

Click \texttt{Take a new picture} in the \texttt{Camera Tasks} box.

You can use the application hot key \texttt{F10} to take still pictures if you have installed the hot key driver. (See \textit{“PC Camera Hot Key Buttons” on page D - 43}.)

---

\begin{center}
\textbf{Windows XP Information}
\end{center}
PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows (see Figure D - 24 on page D - 40).

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio input from the Mixer device menu.
5. Click Mic Volume (check box) if it is not checked, then click OK.
6. Make sure the Select (check box) in the Recording Control panel, under the Mic Volume section, is checked (boost the volume as high as it will go).
7. Close the window, and then click OK.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Realtek HD Audio input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
Windows XP Information

Figure D - 24
Audio Setup
(Windows XP)
BisonCap

BisonCap is a video viewer useful for general purpose video viewing and testing, and can capture video files to .avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > Bison-Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “Audio Setup (Windows XP)” on page D - 40) and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size (see the sidebar - Pre-Allocating File Space) for the captured file. Click Start Capture again.
4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., choose a file name and location, and then click Open (you can view the file using the Windows Media Player).

Set Capture File

In the BisonCap application you will only be asked to set the capture file name on the first run of the program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture. Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).

Pre-Allocating File Space

You may pre-allocate the file size for the capture file in the BisonCap application. You can choose to ignore this by clicking Cancel.

Pre-allocating space on the hard disk can improve the capture quality (particularly of large capture files), by reducing the amount of work the hard disk has to do in finding space for the video data as it is being captured.

You may find it helpful to defragment the HDD before capture.
Eliminating Screen Flicker
If you find that the video screen in the BisonCap application is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure D - 25
Video Capture Filter
PC Camera Hot Key Buttons
You can use the PC Camera Hot key buttons (the quick button driver must not be installed - see “Application Quick Button (WinXP)” on page D - 34) to run the BisonCap program, to take still pictures and to Zoom the camera in and out (if you have installed the hot key and PC Camera drivers - see “Hot Key (WinXP)” on page D - 34 & “PC Camera Driver Installation” on page D - 38).

1. Make sure the PC Camera is on (use the Fn + F10 key combination to power on the camera).
2. Press the application hot key once.
3. The BisonCap application will run.
4. Use the zoom keys to obtain the picture required.
5. Press the application hot key for a second time (you will hear a camera motor sound to indicate the picture is being taken).
6. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

The Snapshot folder’s default location is on the desktop. Do not move this folder or an error may appear when you try to take a still picture using the application hot key.

If you accidentally delete or move the folder, you can create a new Snapshot folder on the desktop in order to capture the files.

Figure D - 26
Snapshot Folder
Wireless LAN Module

If you have included an Intel PRO/Wireless 3945ABG (802.11a/b/g) PCIe WLAN module or 802.11 b/g USB WLAN module in your purchase option, make sure that the Wireless LAN module is on (the LED will be green and the indicator will briefly be displayed when the module is powered on) before installing the driver. Make sure you install the drivers in the order indicated in Table D - 4, on page D - 30.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the Fn + F11 key combination to toggle power to the Bluetooth module, and check the indicator to see if the module is powered on or not (see Table 1 - 3, on page 1 - 8 Table 1 - 5, on page 1 - 11).
Intel WLAN Driver Installation

1. Press the **Fn + F11** key combination to power on the WLAN module.
2. Insert the *Device Drivers & Utilities + User’s Manual CD-ROM (WinXP)* into the CD/DVD drive.
3. Click **Install Options Drivers**.
4. Click 3. **Install WLAN Driver > Yes**.
5. Click **Install Software** (button).
6. Click the button to accept the license and click **Next > Next > OK**.
7. Click **OK** to complete the installation.
8. Configure the settings by going to the **Intel (R) PROSet Wireless** control panel (Start > Programs/All Programs > Intel PROSet Wireless), or double-click the taskbar icon 📲_wifi.

**User Guide**

Insert the *Device Drivers & Utilities + User’s Manual* CD-ROM and navigate (Browse..) to D:\Drivers\WLAN\Auto-run.exe.

Click **View User Guide** (button) as per *Figure D - D - 27*.

You can also view the **Help** menu from the Intel(R) PROSet/Wireless control panel (or press F1 to bring up the help menu when the control panel is active).

*Figure D - 27*

Intel PROSet/ Wireless
Windows XP Information

802.11 b/g WLAN Driver Installation
1. Press the Fn + F11 key combination to power on the WLAN module.
3. Click Install Options Drivers.
4. Click 3. Install WLAN Driver > Yes.
5. Choose the language you prefer and click OK.
6. Click Next (click Continue Anyway if asked if you want to continue at any time).
7. Click Finish to complete the installation.
8. The operating system is the default setting for Wireless LAN control in Windows XP.
9. Access any available wireless networks from the Network Connections control panel in Windows (Start > Settings > Network Connections OR Start > Connect To > Show all Connections) or by clicking the taskbar icon.

Figure D - 28 - Wireless Network Control Panels

D - 46 Wireless LAN Module